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in women of all ages. There are numerous recent
publications clarifying the importance of a gynecologic
oncologist in the care of subjects with ovarian cancer. The
National Comprehensive Cancer Network (NCCN) [1] and
the Society of Gynecologic Oncologists (SGO) [2] plus other
studies have demonstrated the value of referring subjects
with ovarian cancer to gynecologic oncologists for their
surgery [3,4].
OVA1® should be used in conjunction with imaging studies
and other clinical assessment in a woman for whom surgical
intervention is planned. OVA1® can assist the decisionmaking process of whether to refer the subject to a
gynecologic oncologist, when the referring physician’s
presurgical assessment does not indicate malignancy.
OVA1® is a device that incorporates the biomarker values
from five immunoassays. The biomarker values used to
generate the OVA1® result are Prealbumin – also called
transthyretin (TT), Apolipoprotein A-1 (Apo A-1), β2
Microglobulin (β2M), Transferrin (Tfr), and Cancer Antigen
125 (CA 125 II) [5-7]. Biomarker values are determined
using assays on the Siemens BN™ II System (TT, Apo A-1,
β2M, Tfr), which is an automated immunonephelometer, and
on the Roche cobas (CA 125 II), an automated analyzer with
electrochemiluminescence detection. The biomarker assays
are conducted according to the manufacturer’s directions as
detailed in the Instructions for Use for each product and in
this Instructions for Use. The assay values from the following
systems are manually entered into a .csv file and evaluated

Intended Use
OVA1® is a qualitative serum test that combines the results
of five immunoassays into a single numerical result. It is

by the OvaCalc software:
Siemens BN™ II:

indicated for women who meet the following criteria: over

•

TT — Prealbumin (transthyretin) (Siemens)

age 18, ovarian adnexal mass present for which surgery is

•

Apo A-1 — Apolipoprotein A-1 (Siemens)

planned, and not yet referred to an oncologist. OVA1 is an

•

β2M — Beta-2 Microglobulin (Binding Site)

aid to further assess the likelihood that malignancy is

•

Tfr — Transferrin (Siemens)

®

present when the physician’s independent clinical and
radiological evaluation does not indicate malignancy. The
test is not intended as a screening or stand-alone diagnostic

Roche cobas:
•

CA 125 II (Roche)

The OvaCalc software combines the results from these five

assay.
PRECAUTION: OVA1® should not be used without an
independent clinical/radiological evaluation and is not
intended to be a screening test or to determine whether a
patient should proceed to surgery. Incorrect use of
OVA1® carries the risk of unnecessary testing, surgery,
and/or delayed diagnosis.

biomarker assays and then uses a proprietary algorithm to
generate an OVA1® result.

Principles of the Procedure
Principles of the individual assays for Prealbumin (TT), Apo
A-1, β2M, Transferrin (Tfr), and CA 125 II are as given in the
respective Instructions for Use.

Page 2 of 20

PRC000391 v 2.00

Vermillion, Inc.
Patients are assigned a unitless result between 0.0 and 10.0

provided in print by Vermillion, Inc. can be used for

by the OvaCalc software; the result is called the OVA1®

OVA1®. Refer to www.OVA1test.com for Vermillion

score. This result is given in the OVA1® report as written

qualified reagent lots.

below:

•

You should notify Vermillion if you detect problems
with any of the assays used in the OVA1® test.

Pre-menopausal
Low probability of malignancy

OVA1® < 5.0

Users should heed the warnings and precautions

High probability of malignancy

OVA1® ≥ 5.0

listed in each of the Instructions for Use for the
individual assays, in addition to those listed here.

Post-menopausal
Low probability of malignancy

OVA1® < 4.4

High probability of malignancy

OVA1® ≥ 4.4

•

Only the reagents and systems specified in the
Materials Required, Not Provided section are for
use with OVA1®. The performance of OVA1® has

All reagent information for each individual assay that is run

not been evaluated with any other manufacturer’s

can be found in the following Instructions for Use (Note: In

reagents or systems.

the β2 microglobulin Instructions for Use calibrators are
included in each kit and are listed under REAGENTS. In the
Instructions for Use of the other four assays calibrators are
listed under Materials Required, Not Provided):
•

Siemens N Antisera to Human Prealbumin

•

Calibrator: N Protein Standard SL (human), REF
OQIM

•

Use routine laboratory precautions. Do not eat,
drink, or smoke in designated work areas.

•

Do not use heat-inactivated samples or samples
stabilized with azide.

IMPORTANT: It is critically important to have a second
operator (reading from the Siemens BN™ II and Roche
cobas source reports) verify all manually entered values

•

Siemens N Antisera to Human Apolipoprotein A-1

and specimen IDs, after data entry into the .csv data file

•

Calibrator: N Apolipoprotein Standard Serum

but prior to manually merging (importing) the data from

(human), REF OUPG

the Excel data file into OvaCalc. (Please refer to Section

Binding Site Human Beta-2 Microglobulin Latex

4 Running OvaCalc Software for a complete explanation

Enhanced Nephelometric kit, LK043.T

of data importing and further verification.)

•
•

Calibrator: β2M calibrators and controls, LK043.T

•

Siemens N Antisera to Human Transferrin

•

OVA1® is for use with serum only.

•

Calibrator: N Protein Standard SL (human), REF

•

Do not use plasma for OVA1®.

•

Do not use specimens that are heat-inactivated or

OQIM
•

Roche CA 125 II

•

Calibrator: Cat. No. 07030207190, CA 125 II

stabilized with azide.

CalSet, 4x1mL

Serum specimens must be completely
coagulated and, after centrifugation, must not
contain any particles or traces of fibrin.

See PRECAUTION in box following the intended
o

Lipemic samples or frozen samples that are
turbid after thawing must be clarified by

Siemens BN II parameters and calibrators have to
be changed for the Binding Site β2M Assay.
Calibrators are matched to the kit. Please use only
calibrators that are matched to the β2M kit –
calibrators are not interchangeable between
kits.

•

As specified in the Instructions for Use of the

o

use statement.
•

•

individual biomarker assays:

Warnings and Precautions
For In Vitro Diagnostic Use
•

Specimens

centrifugation (10 minutes at ~15,000 x g) prior
to testing. Lipemic samples that cannot be
clarified should not be used. For testing, the
clarified portion of the sample must be used,
and must be drawn through the supernatant
lipid layer.

Only lot numbers for Prealbumin (transthyretin)),
Apolipoprotein A-1, β2 microglobulin, Transferrin,
and CA 125 II posted on the Vermillion website or
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o

ambient temperature (20-25°C) before
measurement.
o

Table 2.

Ensure serum specimens to be tested are at

Diluted samples must be used within 4 hours of
dilution.

Serum specimen stability.



Fresh serum stored at +2 to +8°C can be used up
to 8 days.



Serum frozen within 24 hr at –20°C is stable up to 9
weeks.



Serum frozen within 24 hours and stored at –65 to
–85° is stable up to 12 weeks.

Storage
The storage and stability of the OVA1® individual assays is

Materials Provided

summarized below.

OvaCalc Software for download from www.OVA1test.com.

Table 1.

Materials Required, Not Provided

Stability of OVA1® reagents.
CA 125
(Roche)

Transferrin
(Siemens
[Dade
Behring])

ß2
microglobulin
(Binding Site)

Storage

+2 to
+8°C
Do not
freeze

+2 to +8°C
Do not freeze

+2 to +8°C
Do not
freeze

Stability
once
opened

12
weeks
at +2 to
+8 °C

Reagents for 1
week
Calibrators and
controls for 4
weeks
at +2 to +8 °C

4 weeks
at +2 to +8
°C

6 weeks

Open vials
should not be
left on the
analyzer when
they are not in
use.

A maximum
of 5 days for
5-mL vials,
and 3 days
for 2-mL
vials
at 8 hours
per day

On-board
Stability

Prealbumin
(Siemens
[Dade
Behring])

Apolipoprotein A-1
(Siemens [Dade
Behring])

Storage

+2 to +8°C
Do not freeze

+2 to +8°C
Do not freeze

Stability
once
opened

4 weeks
at +2 to +8 °C

4 weeks
at +2 to +8 °C

On-board
Stability

A maximum
of 3 days at
8 hours per
day
for 2-mL vials

A maximum of 5 days
for 5-mL vials, and
3 days for 2-mL vials
at 8 hours per day

Table 3.

Materials required
Assay

Human Apolipoprotein A1:

Calibrator: N Apolipoprotein
Standard Serum (human), REF
OUPG

Control: Apolipoprotein Control
Serum CHD (human), REF OUPH

Manufacturer

Siemens

β2 Microglobulin:

Calibrator: included in Human Beta2 Microglobulin Latex kit, LK043.T

Controls: included in Human Beta-2
Microglobulin Latex kit, LK043.T

Binding Site

Human Transferrin :

Calibrator: N Protein Standard SL
(human), REF OQIM

Controls: N/T protein Controls SL/L,
M and H (human), REF OQIN,
OQIO, OQIP

Siemens

Human Prealbumin:

Calibrator: N Protein Standard SL
(human), REF OQIM

Controls: N/T protein Controls SL/L,
M and H (human), REF OQIN,
OQIO, OQIP

Siemens

Cancer Antigen 125 (CA 125 II):

Calibrator: Cat. No. 07030207190,
CA 125 II CalSet, 4x1mL

Cat. No. 11776452160, PreciControl
Tumor Marker, for 2 x 3 mL each of
the PreciControl Tumor Marker 1
and 2

Roche

Non-reagent materials
Excel software, version 2003 or later

Microsoft

Individual materials for each of the above listed assays are
found in the respective Instructions for Uses. Only Vermillion
qualified lot numbers for Prealbumin, Apolipoprotein A-1, β2
microglobulin, Transferrin, and CA 125 II posted on the
Vermillion website or provided in print by Vermillion, Inc. can
be used for OVA1®. Refer to www.OVA1test.com for
Vermillion qualified and released reagent lots.
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The Siemens BN™ II System and the Roche cobas system

Procedure

are the required platforms. All information on Use,

IMPORTANT: Only the specific assays listed in this

Installation, Principles of Operation, Performance

Instructions for Use can be used to generate the OVA1®

Characteristics, Operating Instructions, Precautions, and

result.

Limitations, Hazards, and Maintenance for the instruments
can be found in the respective Instrument and/or Software
Manuals for the BN™ II and cobas Systems.
Minimum computer requirements for OvaCalc Software:
•

OvaCalc 3.0.3 runs on both Windows XP and Windows 7
operating systems.

1

Note: This procedure is done only the first time you use

Operating System - Microsoft Windows XP

•

Free disk space - 100 MB

•

Processor - 1 GHz

•

Memory - 512 MB RAM

Installing OvaCalc Software
the software, and anytime you need to reload the software
onto your computer.

A.

Verify that the date and time are correct on your
computer system.

Assay Characteristics and Components

B.

Information on assay characteristics for each of the

i.

To install OvaCalc, go to www.OVA1test.com.
Click OvaCalc Software and log in by entering your

individual biomarker assays can be found in the respective

Username and Password. (Note: Web site usernames

Instructions for Use and Table 4 following.

and passwords are unique for OvaCalc Software
operators and are obtained from Vermillion.).

Table 4.
Performance characteristics of the
individual biomarker assays in OVA1®.
Biomarker

Double-click Download OvaCalc Software, then click
Run in the File Download window to start downloading

Measuring
Interval

the software.
iii.

ß2M
(Beta-2 microglobulin)

0.7 – 22.5 mg/L

Tfr
(Transferrin)

35 – 560 mg/dL

TT
(Prealbumin also known as
transthyretin)

ii.

Follow instructions on where to store OvaCalc on your
computer (OvaCalc installs automatically onto your
computer).

iv.

To run OvaCalc, double-click the OvaCalc icon in
Windows.

2 – 60 mg/dL

C. Log in using the default OvaCalc Administrator account
(username and password are case sensitive):

Apo A-1
(Apolipoprotein A1)

19 – 600 mg/dL

CA 125 II
(Cancer antigen 125)

2.0-3000 IU/mL

•

Username — admin

•

Password — admin123

D. In the main toolbar, click Manage Users (

) and

Controls Required for Each Biomarker
Assay

change the username and password of the OvaCalc

Each biomarker assay control must fall within the expected

1)

Select admin and click Edit.

range for the controls used with the assays. Follow

2)

Type new name and password, then click OK.

manufacturers’ instructions for tracking the controls and
instrument calibration data over time. Instrument calibration
must be performed per the manufacturer’s recommendations
or when controls are out of specification.

Administrator account.

E.

Create one or more new user accounts at this time.
Note that user accounts can be Administrative (full
access) or Basic (restricted access).
1)
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2)

Enter new user information, then click OK.

3)

Repeat for as many users as needed. New users
are listed in the Manage Users window. When
done, click OK.

F.

Exit the OvaCalc software.

2.

Activation

You must obtain an Activation Code for each computer for a
defined number of OVA1® tests from Vermillion before you

can run OvaCalc.
A.

Open OvaCalc software and log in:
•

User– admin

•

Password – admin123
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B.

Select File > Counter Log.

G. In the Add Activations window, enter your Activation
Code and click OK.

•

The current activations and last purchased number
and date are shown in the Counter Log window.

C. In the Counter Log window, record your System ID,
found in the upper right.

D. Send an email to OVA1data@Vermillion.com with the

•

following:

Note that an Activation Code can be used only
once. Activations are deducted after each data

•

Your System ID

•

Your request for an Activation Code for a specific

import and a new activation code must be obtained
from Vermillion when all activations are used up.

®

number of OVA1 tests (500, 1000, 2000, 5000, or

3.

1 million tests).
E.

When you receive your Activation Code, select File >

Automated QC Control

A. Select File > QC Control.

Counter Log.
F.

Click Activate.

B. In the QC Control window, go to Processing Frequency
and select Daily or Weekly, then click OK to close the
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window or click Process Files Now to perform a QC check
immediately.

D. To view, print, and save the OVA1® scores of the five QC
Controls and the accumulated record of performed QC,
select File >QC Report (or click

in the tool bar).

A QC Results
Report (PDF) is
generated.
Click Print and/or
Save in the report
toolbar.

Note: Embedded data from the five QC Controls spanning
the OVA1® range are automatically imported to calculate

E. In the Audit Trail window, select the Start and End dates

scores based on your selected frequency.

you want, then click Query to view the Audit Trail. The Audit

C. When you open OvaCalc, a Success pop-up dialog box

Trail includes the date and time that QC was performed and

opens to indicate that QC Control has been performed

the calculated OVA1® scores of the five embedded QC

OVA1®

according to the processing frequency and all QC control

Controls.

tests pass. Click OK to close.

F. Copy the Audit Trail to an Excel spreadsheet.
i)

Right click over the entries to open the

context menu.
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ii)

Select Copy Table.

iii)

Paste the table into your Excel worksheet.

and evaluating the lot-specific reference curves,
and framing specimen batches with control
measurements.

4.

•

Running the Biomarker Assays

displays of the distribution of the measured results

Run each of the following Biomarker Assays according to the

around the target value of a QC test, as detailed in

manufacturer’s instructions in the respective Instructions for

the Software Guide. The calibration information

Use. For Warnings and Precautions, Materials Required but

encoded in the reagent pack is used to update the

Not Provided, and other detailed information, consult the

master curve. This process is specific to the

appropriate Instructions for Use.
A.

reagent lot and/or pack.

For the following assays: Apo A-1 (Polyclonal Antihuman Apolipoprotein A-1 and Apolipoprotein B

5.

Immunoassay, Siemens), β2M (Monoclonal Anti-human

A.

β2 Microglobulin Immunoassay, Binding Site), Tfr
(Polyclonal Anti-human Transferrin and Haptoglobin

i.

ii.

the BN™ II and cobas. These measurement units

Load reagents, specimens, and controls on your

never vary and are listed in the Procedure Section:

BN™ II instrument as instructed in the Instruction

3)

2.A. 4.
iii.

Follow Instruction Manual instructions for ordering

cobas source reports) verify all manually entered

serum

values and specimen IDs, after data entry into the .csv

Upon setup completion, all steps are performed

data file but prior to manually merging (importing) the

automatically by the system.

B.

IMPORTANT: It is critically important to have a second
operator (reading from the Siemens BN™ II and Roche

appropriate tests on calibrators, QC or patient

4)

Note: The biomarker values are manually entered into
the.csv data file in the measurement units provided by

instructed in the BN™ II Instruction Manual.

Manual.

Excel is used to manually enter specimen IDs and

(.csv) data file.

Immunoassay, Siemens):

2)

Prepare Data for Analysis

assays, saving the data as a comma-separated values

human Prealbumin and Retinol-binding Protein

Set up your BN™ II instrument for the run as

Preparing Data for OvaCalc Software Analysis

results from the Siemens BN™ II and Roche cobas

Immunoassay, Siemens), and TT (Polyclonal Anti-

1)

For assays run on the cobas, a QC screen includes

data from the Excel data file into OvaCalc. (Please

The instrument automatically calculates and prints

refer to Section 4 Running OvaCalc Software for a

the concentration of Apo A-1 in mg/dL, β2M in mg/L,

complete explanation of data importing and further

Tfr in mg/dL, and TT in mg/dL.

verification.)

CA 125 II (Immunoassay using Monoclonal Antibodies

B.

Enter your data into a new Excel workbook created for

to CA 125, Roche)

OVA1® (only one sheet may be used in the workbook).

1)

Create columns with headings as follows:

Set up your cobas instrument for the run following
the analyzer-specific assay instructions in the
appropriate Operator’s Manual.

2)

Bring reagents to approximately 20oC and place on

B.

APO

D. TRF (TFR also accepted)

IMPORTANT: Avoid the formation of foam.
Note: The system automatically regulates reagent
temperature and opening/closing of bottles.
The analyzer automatically calculates the CA 125
concentration of each specimen in IU/mL.

i.

E.

TT

F.

CA125

For columns B through F, use the Excel drop-down list
Format > Cells to select two-decimal numeric display.

C. Enter the Specimen ID and biomarker values for each

C. Calibration and QC
•

Specimen ID

C. B2M

reagent disk of analyzer.

3)

A.

specimen in rows under the column headers created in

For assays run on the BN™ II, see the Quick

step 3 B.

Reference Guide BN™ II System for information on
running controls that meet assay criteria, calibrating
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Note: If any of the biomarker values are automatically

.csv file in Excel and edit it to correct the duplication.

flagged from the BN™ II or cobas they should not be entered

The resaved .csv file can then be re-imported into the

into the Excel workbook sheet and used for OvaCalc.

OvaCalc database.

OVA1® results should be calculated only with valid results

2)

Save your QC’d .csv data file.

for all analytes from a single serum specimen.
i.

6. Running OvaCalc Software and Data Analysis

The operator must re-analyze any specimen that is
flagged for any of the biomarker values from the BN™

Note:
•

II or cobas.
ii.

specimen (sample) ID and biomarker values are

sequence less than 64 characters long. Biomarker

manually entered by the operator from the BN™ II

readings are entered as numbers, without commas or

and cobas
•

other special characters. Each line in the .csv file must

An OvaCalc “folder” is a Windows file folder created

contain a specimen ID and five biomarker readings to

or selected by the operator in OvaCalc. The data

obtain an OVA1® result. If a column is blank or a

are imported from the .csv data file into the

biomarker value is missing, OvaCalc will not produce

OvaCalc folder.

an OVA1® result, and a processing error message will

•

result. If the readings are not parsed as numbers they

Data can only be imported into the OvaCalc folder
from the .csv data file. Data cannot be manually

will not be read.
iii.

A “file” refers to the .csv data file where the

The specimen ID can be any unique character

entered into the OvaCalc folder.

Operators can enter and save data from several
specimen runs through Excel into a single .csv data file

A.

) from the desktop

in. (Installing OvaCalc, above.)

database. No specimen ID should appear more than
once in a single .csv file. If a specimen is analyzed

Launch the OvaCalc software (

shortcut icon or from the Windows Start menu and log

before the data are imported into the OvaCalc
B.

In the OvaCalc main toolbar, click New Folder

(i.e., on the BN™ II or cobas) more than once, and
calculation of the OVA1® result is needed for each set
of analyte values, then the separate sets of values
should be entered into separate .csv files and imported
into separate OvaCalc folders (see below).

(

C. Name the new folder and click OK.
i.

pane opens.

In the Save As dialog box, select CSV (Comma
delimited)(*.csv) from the Save As Type drop-down list,

F.

The new folder is listed in the Explorer pane, toolbar
icons become enabled, and an empty Specimen View

D. Select File > Save As.
E.

).

D. Click Import Data (

), then click Import from file

enter a file name, then click Save.

to open the navigation window, navigate to and select

In the Excel dialog boxes that open, click OK, then click

the .csv file(s) to import for the run, then click Open.

Yes to confirm .csv format.

i.

1)

For every specimen ID that is identified during
import, OvaCalc checks if the specimen ID is already in the

G. Perform a manual QC on the .csv data file.
Have a second operator manually compare the

OvaCalc database for the current OvaCalc folder. If a

Specimen IDs and values obtained from the BN™ II

matching specimen ID is not found in the OvaCalc folder, a

and cobas source reports with the data in the .csv

new record (for the specimen) is created in the OvaCalc

data file. The second operator should correct any

folder. If a matching record (specimen ID) is found, the

discrepancies, and confirm these corrections with

newly imported biomarker values are merged into the

the original operator.

existing specimen ID record. New biomarker values will
amend existing readings in the OvaCalc database for the

IMPORTANT: If a sample ID appears more than once in

current folder; therefore the operator must create a new

a .csv file, an OvaCalc error message appears when the

folder when the same specimen ID has new biomarker

data file is being imported into the OvaCalc database,

value(s) and both records are to be retained.

stating Duplicate Sample ID and displaying the ID
number (e.g., Duplicate specimen id 4007-1 in line 6).
You must cancel the import operation, then reopen the

Page 10 of 20
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Note: If you do not want to export the Run Report as a

imported to a single OvaCalc folder. OvaCalc
®

E.

calculates the OVA1 result only after all five (5)

.csv file, click Cancel in the Save window to open the

biomarker values have been imported.

Run Report without saving.

In the Import dataset window, review the imported data
and click Next to see the list of all specimens and

4.

report toolbar to save.

values in the import. Continue clicking Next and follow
prompts to confirm data. The import wizard prompts for

5.

You may also print or examine the report using the

data review before finalizing the import – this is a very

report toolbar. When done, click OK at the bottom of the

important step to ensure that biomarker values are

report window.

correct. If the operator detects any incorrect entries, the

8. Automatic sending of Counter Log to
Vermillion

import operation must be cancelled, the value(s)
amended and confirmed in the .csv data file (opened in
Excel, edited and resaved), and the .csv file must be re-

A.

OvaCalc automatically sends a counter log to
ova1data@vermillion.com once a week, starting from

imported. The final page of the import wizard shows run

the date of installation. When OvaCalc is opened, a

dates.
F.

To save as a .pdf file, go to the report window, use the

counter log is automatically exported and saved to the

When done, click Finish and all data for the current

hard drive of computer with the default filename of

OvaCalc folder are displayed in the Specimen Result

UsageCount_mm_dd_yyyy, where mm_dd_yyyy

View pane. In the Specimen Result View, a table with

represents the month, day and year of export.

data for each Specimen ID and the OVA1® result is
given. You can click and drag the margins of the

B.

A dialog box confirms that counter log has been saved.

columns to change viewing size. The run is
automatically saved in OvaCalc for all OVA1® results
and five (5) biomarkers for each specimen ID. Operator
should confirm/release the entire “run” before
processing/printing any final reports.
C. A second dialog box confirms that counter log has been

7. Printing Final Reports
1.

Highlight the specimens for the report by clicking and

sent to Vermillion.

dragging the mouse over the appropriate rows.
2.

In the main toolbar, click Physician Report
(

3.

) to view, print and save the report.

To export the Run Report as a delimited .csv file, go to
D. In the event of email failure, the following dialog box
the main toolbar and click Run Report (

). In the

opens.

Save window, create a file name and save the Run
Report as a .csv file (make sure that .csv files is
selected for Files of Type). In the OvaCalc confirmation
dialog box click OK. The Run Report opens after
clicking OK.

Result Reporting
A run report is generated for operator verification and lists
Specimen ID and OVA1® result. A flag is displayed in the
Flag column if the value cannot be reported or there is no
value.
The report to the Physician is patient specific and should be
released only after all the results in the run report are verified
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Endometrial
Cancer

by the operator. This report contains the same information
as in the run report (the requesting physician’s and

Lung
Cancer

Leukemia

Lymphoma

OVA1® result

laboratory director’s information with the specimen
information, e.g., Patient DOB and age, and report date can
be written in by operator after printing).
®

N

44

10

13

13

Mean (SD)

5.00
(1.467)

6.04
(0.651)

4.17
(0.884)

5.26
(1.669)

Median

4.6

6.1

4.0

4.6

5th to 95th
percentile

3.5 to 8.3

4.6 to 7.0

3.0 to
5.5

3.0 to 8.6

The results for OVA1 are as follows:
Pre-menopausal
Low probability of malignancy

OVA1® < 5.0

High probability of malignanc

OVA1® ≥ 5.0

Post-menopausal
Low probability of malignancy

OVA1® < 4.4

High probability of malignancy

OVA1® ≥ 4.4

Table 6.
Expected OVA1® results for subjects with
non-cancer conditions.
Autoimmune
Disease

Refer to clinical study section below for information about
N

10

12

40

Mean (SD)

5.23
(1.083)

5.28
(1.345)

4.39
(1.069)

Median

5.3

5.6

4.0

5th to 95th
percentile

3.4 to 6.6

3.3 to 8.0

3.2 to 6.4

medical history, clinical presentation and other findings. See
PRECAUTION statement following the intended use at the
beginning of the Instructions for Use.

Expected Values

Diabetes

OVA1® result

determining menopausal status. Results of this test should
always be interpreted in conjunction with the patient’s

Cardiac
Disease

The distribution of OVA1® results determined in specimens
Endo- Hepatitis Kidney Pregnant
metriosis
Disease Women

from healthy individuals and patients with nonmalignant or
malignant diseases other than ovarian cancer is shown in

OVA1® result

the following tables. A total of 360 evaluable specimens
were analyzed. The mean, standard deviation, median, and
5th to 95th percentile as observed in the data are shown for
each group. It is recommended that each laboratory
establish its own reference range for the population of
interest.
Expected OVA1® results for subjects with cancer conditions

N

40

13

10

12

Mean (SD)

5.01
(1.189)

4.46
(0.832)

5.23
(1.083)

5.28
(1.345)

Median

4.7

4.2

5.3

5.6

3.4 to
6.6

3.3 to 8.0

5th to
3.4 to 7.1 3.5 to 6.0
95th
percentile

other than ovarian cancer are presented in Table 5 following.
Expected OVA1® results for subjects with non-cancer

Anemia

conditions are presented in Table 6 following.
Table 5.
Expected OVA1® results for subjects with
cancer conditions.
Bladder
Cancer

Breast
Cancer

Cervical
Cancer

Colon
Cancer

OVA1® result
N

16

45

12

40

Mean (SD)

4.57
(1.109)

4.34
(1.151)

6.40
(1.979)

4.86
(1.259)

Median

4.4

4.1

6.6

4.8

5th to 95th
percentile

2.9 to 6.5 2.9 to 6.0

3.4 to 9.8 3.0 to 7.0

Pelvic
inflammatory
disease

Malnutrition

OVA1® result
N

11

9

10

Mean (SD)

3.73
(0.673)

4.52
(1.072)

4.30 (0.948)

Median

4.0

4.4

4.4

5th to 95th
percentile

2.7 to
4.7

3.2 to 6.3

2.8 to 5.7

Reference Values
OVA1® results in healthy women, 69 pre- and 78 postmenopausal were evaluated (total = 147 evaluable subjects).
Ages ranged from 18 to 85 and represented whites (81.3%)
Hispanic/Latino (8.7%) and African American (7.3%)
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subjects. Expected OVA1® results for healthy subjects are

Problem

presented in Table 7.
Table 7.
Summary of OVA1® results by
menopausal status for evaluable women.
All
Healthy
Subjects

Premenopausal
Women

Postmenopausal
Women

N

147

69

78

Mean (SD)

4.18
(0.858)

4.34 (0.871)

4.04 (0.827)

Median

4.10

4.30

3.95

Range
(min, max)

2.7, 6.7

2.9, 6.7

2.7, 6.1

3.0, 5.8

2.9, 5.9

Reference
interval
(5th
percentile,
95th
percentile)

3.0, 5.8

Cannot print
reports.
Report printed
with header
missing.

OVA1® Result, n (%)
Positive

46 (
31.3% )

20 ( 29.0% )

26 ( 33.3% )

Negative

101 (
68.7% )

49 ( 71.0% )

52 ( 66.7% )

Troubleshooting
Problem
Error message –
Imported data file
cannot be read.

Error message –
Duplicate
Specimen ID in
the Excel .csv
data file.
Eg: Duplicate
specimen id
4007-1 in line 6
Error message –
Specimen
missing one or
more values.

Possible Cause and Solution
Possible corruption of .csv file.
Review .csv data file.
Re-enter Specimen IDs and/or
results as needed.
Import corrected file into
OvaCalc software.
Review .csv data file and correct
any duplications.
Import corrected file into
OvaCalc software.

1. Possible error in imported
data file.
Review BN II/Elecsys data
output to ensure specimen ID
has a marker result.
Reconcile with .csv data file.
Re-import into OvaCalc
software.
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Specimen IDs in
OvaCalc result
table not in
sequential order

Possible Cause and Solution
2. Possible syntax error in data
file.
Review .csv file and correct
column headings to match
following:
Specimen ID
APO
B2M
TFR
TT
CA-125
Ensure Specimen ID and all
values are entered correctly.
Import corrected file into
OvaCalc software.
Printer-specific problem.
Save report as a PDF and print
the PDF.
Printer-specific problem.
Save report as a PDF and print
the PDF.
Specimen IDs do not show in
the same order as in the
imported .csv file:
Export and save Counter Log
and send to Vermillion for
record-keeping.**
Open Counter Log window and
record or take and save screen
shot of: Current Activations
Number, Last Purchased Date,
and Purchased Number.
Ensure all .csv data files, Run
Run Repots, and QC Reports
are backed up.
Uninstall OvaCalc.
Download the same version of
OvaCalc from
www.ova1test.com.
Install the downloaded OvaCalc
to the same directory as
previous installation on your
computer.
Run OvaCalc. Confirm transfer
of data folders, Counter Log, QC
Report, and Activations.
Note: Downloading to a different
directory deletes the existing
database, counter log, QC, and
activation information.
**Must be done before uninstall.
Existing database and counter
log are not affected only if same
version of OvaCalc is reinstalled.
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•

Limitations of the Procedure

Patient samples may contain heterophilic

Information on the Limitations of the Procedure for each

antibodies and anti-mouse antibodies that could

of the individual biomarker assays is detailed in the

cause false results in some of the immunoassays.

respective Instructions for Use.

Refer to individual Instructions for Use (Apo A-1,

•

7)
•

OVA1® is not a stand-alone diagnostic test. OVA1®
should be used in conjunction with a complete and
independent clinical patient evaluation.

•

•

•
•

•

β2M and CA 125 II) for further details.

OVA1® is not a screening test. (See Tables 6 and

Clinical Study Results
The information provided by OVA1® should be used by the
physician as an adjunctive test to complement, not replace,
other diagnostic and clinical procedures. To demonstrate

A negative OVA1® result, in the setting of a positive

that OVA1® provides additional information when used in

pre-surgical assessment, should not preclude

combination with the physician’s pre-surgical assessment,

oncology referral.

the ability of OVA1® to contribute to the physician’s pre-

Use of this assay is limited to personnel who have

surgical assessment was analyzed.

been trained by Vermillion, Inc. in the procedure.

OVA1® was evaluated in a prospective, double-blind clinical

Failure to follow the instructions given in this insert

study. OVA1® analysis was performed on 516 individual

may result in erroneous results.

serum specimens collected prospectively from women who

OVA1® is not indicated for patients with a diagnosis

met the study inclusion criteria and proceeded to surgery for

of malignancy within the last 5 years.

an ovarian mass. The clinical study population came from

All collected data from each of the individual five

institutions with primary care physicians, gynecologists (non-

biomarkers must be manually transferred from the

GO), and/or gynecologic oncologists (GO). The clinical study

BN™ II or cobas printouts using the same units

subject enrollment centers are representative of institutions

specified by the printouts into the .csv data file

where ovarian tumor subjects potentially undergo a

using Excel. Manual data entry verification must be

gynecologic examination. The specimens were collected at

performed before completing the import into

27 demographically mixed sites that included large and small

OvaCalc software.

medical centers (universities/community hospitals), clinics

Only reagents that have been qualified by
Vermillion are acceptable for use with OVA1®.
Users should verify manufacturer’s lot numbers are

that specialize in women’s health, small
gynecology/obstetrics groups, gynecology/oncology
practices, and HMO groups).

qualified for individual biomarker assays and

Subject enrollment demographics and pathology diagnoses

calibration reagents. Refer to

are given in Table 8.

http://www.OVA1test.com for qualified (released)

Table 8.
Demographic characteristics and
pathology results or physician assessment results
for all evaluable subjects.

reagents or check with Vermillion prior to use with
OVA1®.
•

All Evaluable
Subjects with
GO
Pre-surgical Non-GO
Assessment Physicians Physicians
(N= 516)
(N= 269)
(N= 247)

Samples that have been heat-inactivated or
stabilized with azide cannot be used.

•

Samples that contain rheumatoid factor ≥ 250
IU/mL cannot be used in the OVA1® test.

•

Triglyceride levels above 4.5 g/L may interfere with
the assay and should not be used in the OVA1®
test.

•

Age, years
N

516

Mean (SD)

52.0 (13.9)

Range (min, max)
Follow manufacturers Instructions for Use for CA
125 II, Prealbumin (TT), and β2M for information
about hook effects. There is no high dose Hook
effect for Apo A-1 up to a concentration of 900
mg/dL or for Prealbumin up to a concentration of
300 mg/dL.
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18 to 92

269

247

49.7 (13.6) 54.6 (13.8)
19 to 90

18 to 92

Menopausal Status, n (%)
Pre

235 (45.5%) 144 (53.5%) 91 (36.8%)

Post

281 (54.5%) 125 (46.5%)

Pathology Diagnosis, n (%)

PRC000391 v 2.00

156
(63.2%)

Vermillion, Inc.
All Evaluable
Subjects with
GO
Pre-surgical Non-GO
Assessment Physicians Physicians
(N= 516)
(N= 269)
(N= 247)
Benign ovarian
conditions

158
(64.0%)

355 (68.8%) 197 (73.2%)

Epithelial ovarian
cancer (EOC)

96 (18.6%)

Other primary
ovarian
malignancies (non
EOC)

9 (1.7%)

Table 9.
All non-GO evaluated subjects –
malignancy/no malignancy by pathology.
Malignancy by Pathology
Pre-surgical assessment
OVA1®
result

Pos

Neg

Both

Positive

49

14

63

Negative

3

6

9

Both

52

20

72

45 (16.7%) 51 (20.6%)

No Malignancy by Pathology

Ovarian tumors with
low malignant
potential
(Borderline)

28 (5.4%)

Non-ovarian
malignancies with
involvement of the
ovaries

18 (3.5%)

Non-ovarian
malignancies with
no involvement of
ovaries

10 (1.9%)

5 (1.9%)

12 (4.5%)

4 (1.6%)

16 (6.5%)

Pre-surgical assessment
OVA1®
result

Positive

Pos

Neg

Both

16

81

97

Negative

18

82

100

Both

34

163

197

The analysis examined whether patient referral to a
5 (1.9%)

13 (5.3%)

gynecologic oncologist is supported when either the OVA1®
result or the pre-surgical clinical assessment or both were
determined to be positive.

5 (1.9%)

5 (2.0%)

Table 10 shows results for all subjects evaluated by non-GO,
with “positive” results for likely malignancy either based on a

Note: Menopausal status stated by patient. For 44 evaluable

positive pre-surgical assessment alone (single assessment),

subjects, menopausal status assigned based on age: pre-

or based on a positive result from the pre-surgical

menopausal assigned to women aged 50 or under, post-

assessment or from the OVA1® result or from both (dual

menopausal assigned to women over age 50.

assessment).

Performance of OVA1® for Patients Evaluated by
Physicians who are not Gynecologic Oncologists (nonGO)

Table 10.
All subjects evaluated by non-GO
physicians.
Performance

Single
assessment
(pre-surgical
assessment)

Dual
assessment
(pre-surgical
assessment and
OVA1® Test
result used)

72.2% (52/72)
61.0% to 81.2%

91.7% (66/72)
83.0% to 96.1%

82.7% (163/197)
76.9% to 87.4%

41.6% (82/197)
35.0% to 48.6%

Positive
Predictive
value (PPV)
95% CI

60.4% (52/86)
49.9% to 70.1%

36.5% (66/181)
29.8% to 43.7%

Negative
Predictive
Value (NPV)
95% CI

89.1% (163/183)
83.7% to 92.8%

93.2% (82/88)
85.9% to 96.8%

A total of 269 patients (age range 19-90) were evaluated by
non-GO (e.g., primary care physicians, gynecologists). Of
the 269 patients, 144 subjects were identified as premenopausal and 125 as post-menopausal.
For each patient, the OVA1® result was compared to the

Sensitivity
95% CI

pathology report from biopsied tissue. Malignancy included
epithelial ovarian cancer (EOC), other primary ovarian
malignancy, ovarian tumor with low malignant potential,
malignancy extending to, or metastatic to ovaries, and
malignancy that neither arose in nor involved the ovaries.
High probability of malignancy for premenopausal subjects

Specificity
95% CI

®

was defined as OVA1 result of 5.0 or more; and for
postmenopausal subjects OVA1® result of 4.4 or more.
Among 269 subjects, there were 72 subjects with
malignancy by pathology and 197 subjects with no
malignancy by pathology.

Prevalence

26.8% (72/269)

With dual assessment, sensitivity for malignancy increased
from 72% to 92%. That is, approximately two-thirds of the
malignancies missed by pre-surgical assessment alone were
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called positive if a dual assessment was used. Specificity for
malignant diagnoses decreased from 83% to 42% with dual

Table 12.
Assessment of pre-menopausal subjects
by non-GO and by non-GO plus OVA1®.
Performance

Single
assessment
(pre-surgical
assessment)

Dual
assessment
(pre-surgical
assessment and
OVA1® Test
result used)

increased from 89% to 93%, supporting improved

Sensitivity

65.4% (17/26)

84.6% (22/26)

performance by dual assessment. The confidence interval

Specificity

83.1% (98/118)

45.8% (54/118)

for the observed 4.1% increase was -0.5% to 8.7%

PPV

45.9% (17/37)

25.6% (22/86)

(calculated by bootstrap). The statistical significance of the

NPV

91.6% (98/107)

93.1% (54/58)

assessment. The ratio of false positive results to true
positive results for the study population increased from 34:52
(0.65:1) with single assessment to 115:66 (1.74:1) with dual
assessment (PPV of the dual assessment decreased from
60% to 37%). However, NPV of the dual assessment

observed increase in NPV was borderline.

Prevalence

®

18.1% (26/144)

Performance characteristics of OVA1 with pre-surgical

PPV of the dual assessment decreased from 46% to 26%

assessment for the 269 patients classified according to their

and NPV of the dual assessment increased from 92% to

menopausal status are presented separately in the tables

93%. The confidence interval for the observed 1.5%

below.

increase was -3.3% to 6.4% (calculated by bootstrap).

Pre-menopausal subjects

Post-menopausal subjects

Among 144 pre-menopausal subjects with pre-surgical

Among 125 post-menopausal subjects with pre-surgical

assessment by a non-GO, there were 26 subjects with

assessment by a non-GO, there were 46 subjects with

malignancy by pathology and 118 subjects with no

malignancy by pathology and 79 subjects with no

malignancy by pathology.

malignancy by pathology.

Table 11.
Pre-menopausal non-GO evaluated
subjects – malignancy/no malignancy by pathology.
Malignancy by Pathology

Table 13.
Post-menopausal non-GO evaluated
subjects – malignancy/no malignancy by pathology.
Malignancy by Pathology

Pre-surgical
assessment
®

OVA1
result

Pre-surgical
assessment

Pos

Neg

Positive

16

5

21

Negative

1

4

5

17

9

®

OVA1
result

26

Pos

Neg

Positive

33

9

42

Negative

2

2

4

35

11

46

No Malignancy by Pathology

No Malignancy by Pathology

Pre-surgical
assessment
®

OVA1
result

Positive
Negative

Pos

Neg

7

44

Pre-surgical
assessment
51

13

54

67

20

98

118
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®

OVA1
result

Pos

Neg

Positive

9

37

46

Negative

5

28

33

14

65

79
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Table 15.
Performance of OVA1® alonea compared
to biopsy in patients evaluated by non-GO.

Table 14.
Assessment of post-menopausal subjects
by non-GO and non-GO plus OVA1®.
Performance

Single
assessment
(pre-surgical
assessment)

Dual
assessment
(pre-surgical
assessment and
OVA1® Test
result used)

Sensitivity

76.1% (35/46)

95.7% (44/46)

Specificity

82.3% (65/79)

35.4% (28/79)

PPV

71.4% (35/49)

46.3% (44/95)

NPV

85.5% (65/76)

93.3% (28/30)

Prevalence

36.8% (46/125)

PPV of the dual assessment decreased from 72% to 46%

All

Pre-

Post

N

269

144

125

Sensitivity
95% CI

87.5%
(63/72)
77.9% 93.3%

80.8%
(21/26)
62.1% 91.5%

91.3%
(42/46)
79.7% 96.6%

Specificity
95% CI

50.8%
(100/197)
43.8% 57.7%

56.8%
(67/118)
47.8% 65.4%

41.8%
(33/79)
31.5% 52.8%

NPV

91.7%
(100/109)

93.1%
(67/72)

89.2%
(33/37)

PPV

39.4%
(63/160)

29.2%
(21/72)

47.7%
(42/88)

Prevalence

26.8%
(72/269)

18.1%
(26/144)

36.8%
(46/125)

and NPV of the dual assessment increased from 86% to
93%. The confidence interval for the observed 7.8%
increase was -1.6% to 17.2% (calculated by bootstrap).
a

OVA1® is not intended as a stand-alone diagnostic test.

Performance characteristics for OVA1®, without
reference to the matched non-GO clinical/radiological
assessments for malignancy

subjects with a primary ovarian malignancy (EOC and non-

OVA1® is not for use as a stand alone test.

EOC combined) are summarized in the table below.

Clinical/radiological evaluation is needed in order to identify
patients in the intended use population (women over age 18,
ovarian adnexal mass present for which surgery is planned,
and not yet referred to an oncologist), for whom the

A summary of OVA1® results by cancer stage for evaluable

Table 16.
OVA1® Results by Cancer Stagea for
primary ovarian malignancies in all evaluable
subjects with a pre-surgical clinical assessment
from non-GO.
Stage I

performance characteristics of the test are established.
®

OVA1 performance characteristics, without reference to the
matched clinical/radiological assessments for malignancy,

Stage III

14

11

25

OVA1® Mean (SD)

6.89
(2.313)

8.21
(1.600)

8.36
(1.289)

Median

6.55

8.60

8.70

are summarized in Table 15.
Table 15 below shows performance of OVA1® alone for all

Range
(min, max)

clinical study subjects evaluated by non-GO, and separately
by menopausal status for pre-menopausal and postmenopausal subjects.

Stage II

No. of Subjects

3.6 to 10.0 5.1 to 10.0 5.5 to 10.0

OVA1® Positive

11

11

25

OVA1® Negative

3

0

0

OVA1® Sensitivity

78.6 %

100%

100%

a No

Stage IV Patients were evaluated by non-GO

The subjects identified with an ovarian malignancy were
categorized by histologic subtype. Table 17 shows the
sensitivity of the OVA1® result for each histologic subtype.
95.8% of subjects with epithelial ovarian cancer had a high
risk OVA1® result (≥ 5.0).
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Table 17.

Performance by histological subtype.

Table 19 below shows results for all subjects evaluated by

Patients evaluated by Non-GO
®

either based on a positive pre-surgical assessment alone

OVA1 Risk
Histological Subtype

Low Risk High Riskb

GO physicians, with ”positive” results for likely malignancy

Sensitivity
%

Epithelial

1

44

97.8

Non-Epithelial

2

3

60.0

Low malignant potential

5

7

58.3

Metastatica

0

5

100.0

Non-primary ovarian
malignancies with no
involvement of ovaries

1

4

80.0

(single assessment), or based on a positive result from the
pre-surgical assessment or from the OVA1® result or from
both (dual assessment).
Table 19.

GO evaluated subjects – assessments.

Performance

Single
assessment
(pre-surgical
assessment)

a. Includes subjects with non-ovarian primary malignancy

Dual
assessment
(pre-surgical
assessment and
OVA1® results
used)

with involvement of the ovaries.

Sensitivity

77.5% (69/89)

98.9% (88/89)

b. High risk cut-off: premenopausal subjects OVA1® result

Specificity

74.7% (118/158)

25.9% (41/158)

of 5.0 or more; postmenopausal subjects OVA1® result of

PPV

63.3% (69/109)

42.9% (88/205)

NPV

85.5% (118/138)

97.6% (41/42)

4.4 or more.

Prevalence

Performance of OVA1® for Patients Evaluated by
Gynecologic-Oncologists (GO)

36.0% (89/247)

With dual assessments within the GO-evaluated patients,

OVA1® results in patients evaluated by GO physicians were

sensitivity for malignancy increased from 78% to 99% and
specificity for non-malignant diagnoses decreased from 75%

analyzed for comparison with results in patients evaluated by

to 26% with dual assessment. The PPV decreased from

non-GO physicians.

63% to 43%. However, the NPV increased from 86% to

The following table shows results for the 247 patients

98%. The confidence interval for the observed 12.1%

evaluated by gynecologic oncologists in the clinical study.

increase was 5.7% to 18.6% (calculated by bootstrap). The

There were 89 subjects with malignancy by pathology and

observed increase in NPV was statistically significant.

158 subjects with no malignancy by pathology. Compared to
use of OVA1® in the non-GO evaluated patients, use of
®

OVA1 increased sensitivity and decreased specificity in the
GO-evaluated patients.

Malignancy by Pathology

accordance with CLSI guideline EP5-A2 “Evaluation of
Precision Performance of Quantitative Measurement
Methods; Approved Guideline.” Five serum specimens
spanning OVA1® result range (range of numerical results for

Pre-surgical
assessment

OVA1
result

Precision
Precision performance of OVA1® was evaluated in

Table 18.
GO evaluated subjects – malignancy/no
malignancy by pathology. a

®

Analytical Performance

OVA1®: 0.0 to 10.0) were tested over 20 days, two runs per

Pos

Neg

Positive

67

19

86

Negative

2

1

3

69

20

89

day, and two replicates per run. Total percent coefficient of
variation (%CV) was ≤ 5.2%.
Table 20.
Sample

No Malignancy by Pathology

OVA1® Within-run Betweenrun
(Mean)
SD %CV SD %CV

n

Pre-surgical
assessment
OVA1®
result

aThere

Positive
Negative

Pos

Neg

29

77

106

11

41

52

40

118

158

OVA1® Result Precision

SD

%CV

1

80

2.74 0.065 2.4 0.011 0.4 0.091

3.3

2

80

3.39 0.101 3.0 0.099 2.9 0.159

4.7

3

80

3.74 0.149 4.0 0.097 2.6 0.192

5.1

4

80

4.69 0.290 6.2 0.000 0.0 0.349

7.4

5

80

9.94 0.061 0.6 0.051 0.5 0.098

1.0

were three Stage IV Patients evaluated by GO
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Lot-to-Lot precision
Five serum specimens and a minimum of two control sera
were analyzed at one site with three different reagent kit lots
and three different calibrators over three different days by
one operator. For each of the five specimens and the two
controls, the mean and standard deviation (SD) for each
sample were calculated. The %CV for between-lot
imprecision was ≤ 2.8%.

Reproducibility
Five serum specimens spanning the OVA1® result range
and a minimum of two controls per day were tested in
duplicate, two runs each day, over 6 days, by two operators
at each of three sites For each of the five specimens, the
mean, SD, %CV, median, and range of OVA1® results were
calculated for an assessment of imprecision in the
reproducibility study. The results for OVA1® are shown
below:
Table 21.
Assessment of imprecision from
reproducibility study
Serum Specimen
1

2

3

4

5

9.71

®

OVA1 result
Mean
Repeatability

SD

(within %CV
run)
Between run
Between day
Between
operator
Between sites

2.67

3.21

3.75

5.00

0.069

0.094

0.157

0.364 0.157

2.6

2.9

4.2

SD

0.034

0.087

0.091

%CV

1.3

2.7

2.4

SD

0.000

0.000

0.146

%CV

0.0

0.0

3.9

SD

0.042

0.039

0.105

%CV

1.6

1.2

2.8

SD

0.057

0.141

0.000

%CV

2.1

4.4

0.0

Reproducibility

SD

0.098

0.176

0.250

(total)

%CV

3.7

5.5

6.7

7.3

1.6

0.000 0.129
0.0

1.3

0.032 0.045
0.6

0.5

0.265 0.000
5.3

0.0

0.103 0.212
2.1

2.2

0.447 0.271
8.9

2.8

Note: Contributions to variance from nested model for runs
within days within operators within sites.
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Interference
Three pooled serum samples with low (~3.0), medium (~4.4)
and high (~7.3) OVA1® results were evaluated for
interference by hemoglobin (9.0 g/L) , conjugated bilirubin (
(0.9 g/L) and unconjugated bilirubin (0.9 g/L)), triglycerides

Licensing and Copyright

(4.6 g/L) and rheumatoid factor. No significant interference at

© 2009. The OvaCalc software of the OVA1® test is the

the concentrations evaluated was observed on the OVA1

®

result for any of the interferents evaluated except for
rheumatoid factor. Specimens with rheumatoid factor greater
than 250 IU/mL are not appropriate for OVA1®.
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